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SnapScan™ e26

Owner’s Guide

! Preface

This chapter gives you information about your SnapScan and about How to Use This Online
Guide.

! Chapter 1: Preparing the Scanner

“Preparing the Scanner” explains how to prepare your SnapScan for installation.

! Chapter 2: Installing the Scanner for PC

This chapter shows you how to set up your SnapScan for your PC.

! Chapter 3: Configuring Buttons on Your PC

This chapter shows you how to configure your SnapScan Buttons on your PC.

! Chapter 4: Installing the Scanner for Macintosh

This chapter shows you how to set up your SnapScan for your Macintosh computer.

! Chapter 5: Configuring Buttons on Your Macintosh Computer

This chapter shows you how to configure your SnapScan Buttons on your Macintosh
computer.

! Chapter 6: Making Your First Scan

Here you find instructions on how to place reflective originals on the glass plate of your
scanner.

! Appendix A: Troubleshooting

“Troubleshooting” can be helpful when you come across problems.

! Appendix B: Technical Information

This appendix provides specifications for your SnapScan.

! Appendix C: Regulation Compliance

This appendix gives you information about safety regulations and electromagnetic
compatibility.
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About SnapScan
In this Owner’s Guide, the name SnapScan is used for the SnapScan e26.

The SnapScan is a one pass flatbed color scanner with a resolution of 600 X 1200 ppi equipped
with a cold cathode lamp. It is based on CCD (Charge-Coupled Device) scanning technology. With
the SnapScan, you can scan line-art, gray-scale and color reflective originals up to A4 format.

The scanned data is transferred through the computer’s USB (Universal Serial Bus) port. The USB
technology makes it easy to install multiple peripherals to your computer. USB eliminates any need
to turn off or restart the computer when attaching a new peripheral.

SnapScan is a scanner that captures and converts reflective originals (for example pictures, text)
into electronic data that can be used in computer applications. It offers high-resolution image
capturing and is an ideal tool in making presentations come to life.

SnapScan supports multiple scanning modes and includes scanner software to get you started right
away. With its powerful and easy-to-use scanner driver software, SnapScan gives you easy access
to high-quality color scans. The scanner driver software gives you a number of additional features
to create special effects or to reproduce even the most difficult originals.

In order to enhance the user friendliness, the SnapScan is fitted with three buttons. It is possible to
customize the functions of the buttons by assigning other actions to them.

The document cover is adjustable: when you put a thick original (like a book or a magazine) on the
reflective glass plate, the document cover adapts to the thickness of the original.

Environmental Requirements
" Place the scanner on a horizontal, flat surface.

" To ensure proper ventilation, allow a minimum of 10 cm (4 inches) free space around each
side of the scanner.

" Make sure that no vibrations or shocks occur.

" Make sure that the area is free of dust.

" Avoid any contact with water. Do not use your scanner near water or in a damp environment.

" Your SnapScan is designed to perform at best when the environmental humidity is between
20% and 85%. Avoid environments where humidity fluctuations might occur.

" Your SnapScan is designed to perform at best when the environmental temperature is
between 10 °C (+ 50 degrees Fahrenheit) and 40 °C (+104 degrees Fahrenheit). Avoid
exposure to direct sunlight and heating devices.



Preface 7

Precautions
For your own safety and that of your equipment, respect conscientiously the Environmental
Requirements and always take the following precautions:

" Check frequently whether there is no overheating of the AC adapter.

" If you do not use your scanner for some time, pull the AC adapter cable out of the power
supply socket.

" Handle your SnapScan with care: the glass plate is fragile. There is no warranty on breaking
the glass plate and your dealer is not liable for consequential damages.

" Disconnect the AC adapter when you want to clean the scanner housing or the glass plate and
when the scanner needs servicing or repairing.

" Do not open the scanner housing as it contains high-voltage areas and sensitive components.
Every repair should be carried out by your dealer.

" Do not leave originals on the reflective glass plate for excessive periods of time. The warmth of
the scanner may cause them to deteriorate.

" For safety reasons, never use extension cables for the AC adapter.

Caution: For safety reasons, besides the personal maintenance mentioned in this Owner's Guide,
do not try to remove any mechanical parts or any electronic components from your scanner. If your
scanner needs service, our dealer and service offices are available to help you.

Cleaning Your Scanner
" Cleaning the glass plate regularly, ensures that dirt or smudges do not reduce the quality of

your scanned images.

" Before cleaning, disconnect the AC adapter from your scanner.

" Use a soft damp cloth and a mild detergent to clean the surface of the glass plate. If you use
alcohol to clean the glass plate, make sure that you do not touch the plastic elements of the
scanner.

" Avoid using sprays directly onto the glass plate as this may cause the liquid to penetrate the
seams around the glass and contaminate the mirrors and lenses inside the scanner.

" Do not use liquid cleaners or aerosol cleaners.
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How to Use This Online Guide

To … Click …

jump to another location within or outside the
document

blue text

jump to a topic in the document click the corresponding bookmark

jump to the first or the last page
 

retrace your steps in the document
 

jump to the previous or to the next page
 

zoom in and zoom out (control-click) on the
page

search for a part of a word, a complete word
or multiple words

print the document

# Note: Due to rescaling, some of the screen shots included in this document may appear
unclear when displayed at 100% magnification. You can view these screen shots more clearly
by using the Zoom tool to increase the default magnification.

How to Print This Guide
1 Choose Page Setup from the File menu.

2 Choose your paper format from the Paper popup menu.

3 Select Orientation: Portrait.

4 Click OK.

5 Choose Print from the File menu.
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Chapter 1: Preparing the Scanner

This chapter helps you to prepare your SnapScan for installation.

! Unpacking the Scanner

! Taking a Closer Look

! Changing the Handle

! Unlocking the Scanner
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Unpacking the Scanner
1 Open the packing box and carefully unpack all the items.

2 Check each item to make sure that everything listed on the Packing List (printed on the box) is
present. Check if there is no visible defect.

If something is missing, contact your dealer.

3 Remove the plastic wrapping and the packing materials from the scanner.

# Note: Do not throw away the packing materials. They can be useful to protect the scanner
during later transport.

Taking a Closer Look
When you have taken the scanner out of the box, take a closer look at its parts. The following
figures illustrate the different parts of your SnapScan.

1. Replaceable handle

2. Adjustable document cover

3. Glass plate

4. Status indicator

5. Print button

6. ScanWise button

7. E-mail button
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The following figure illustrates the location of the different parts at the rear of your scanner.

1. Power connector

2. USB Port (labeled with the USB icon ) to make a connection to your computer

Changing the Handle
It is possible to customize your SnapScan by changing its handle.

1 Rotate the handle counterclockwise to remove it.

2 To place a new handle, slide the handle in the correct position and rotate it clockwise.
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Unlocking the Scanner
Before you start using the scanner, you first have to unlock it.

1 Place the scanner on a horizontal, flat surface and pull it carefully towards you until you can
see the locking screw at the bottom.

2 Rotate the locking screw in the direction of .

Your scanner is unlocked.

# Note: If you want to transport your scanner, you have to lock it. To do this, first connect the AC
adapter to the scanner so that its optical assembly moves to its home position. Then, rotate the
locking screw in the direction of  and disconnect the scanner. Your scanner is now locked
and ready for transportation.

Caution: Make sure to install the ScanWise software before connecting the scanner to your PC or
Macintosh computer.
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Chapter 2: Installing the Scanner for PC

This chapter shows you how to set up your SnapScan for your PC.

! Minimum System Requirements

! Installing the Scanner Software

! Connecting the Scanner to Your PC

! Installing Additional Software
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Minimum System Requirements
" A USB port

" A Pentium® processor

" A 14 inch color monitor

" A video card that can display a minimum of 16 bit high color

" 64 MB of RAM

" A CD-ROM drive

" Windows® 98

" ScanWise is compatible with all IBM™ PCs and compatibles running
Windows 98/ME/2000

" The amount of disk space available on your PC determines the number and the size of the
images that you can scan. Make sure that you have enough free storage space on your hard
disk. You need about two times the size of the image to scan, edit and save it.
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Installing the Scanner Software
1 Insert the Agfa ScanWise™ CD-ROM in your CD-ROM drive.

# Note: If the ScanWise Installer program does not appear automatically, carry out the
following instructions:

1 Double-click My computer.

2 Double-click the CD-ROM drive.

3 Double-click Setup.exe.

2 Click the up or down arrow to select your language.

This selection determines the language of the ScanWise software and documentation.

3 Click the up or down arrow to select your type of scanner (if needed).

4 Click the dotted right arrow or move the slider to about ScanWise.

A demonstration of ScanWise will start.

5 Click the dotted right arrow or move the slider to Install.

6 Click Acrobat Reader™ to start the installation.

You need Acrobat Reader to read the documentation.

7 Follow the instructions on your screen.

When the installation is finished, the Install screen appears again.

8 Click ScanWise to start the Installation.

9 Follow the instructions on your screen.

# Note: During installation the Register ScanWise window appears. You can choose to
register now or later.

$ Register now: If you choose to register now, the Agfa webpage opens. Here you can
register online.

$ Register later: If you choose to register later, you can register afterwards via
Start/Programs/Agfa ScanWise/Register ScanWise.
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By registering online, you will create your personal e-Service account and you will enjoy the
following benefits:

1. Customized self-help tools:

You have access to the following self-help tools which are customized according to your
e-service account profile:

1. Software downloads

2. Technical knowledge database (FAQ)

3. Online manuals and documentation

4. Access to third-party software support sites

2. Personalized one-to-one technical support:

Agfa assists you online if you have additional questions about technical issues.

3. Automatic e-mail notification:

Agfa notifies you immediately when new software and upgrades are available for downloading.

# Note: For support issues, go to http://support.agfa.com.

# Note: For the latest information consult the ScanWise Read Me File.

When installation is finished you are ready to connect your scanner to your PC.

http://support.agfa.com/
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Connecting the Scanner to Your PC

Caution: For your safety, use the adapter that comes with this product. Do not use any substitute.
Misuse of the power adapter can cause serious damage to the product and a safety hazard while
using it.

# Note: Check if the AC Adapter complies with your local power supply.

# Note: Make sure the scanner is unlocked (see Unlocking the Scanner) before connecting it to
the electric outlet.

1 Connect the plug of the AC adapter to your scanner.

2 Connect one end of your USB cable to the USB port on your scanner. Make sure you connect
the correct plug as shown in the figure above.

3 Plug the adapter in the wall outlet.

4 Connect the other end of your USB cable to a USB port on your computer. Make sure you
connect it to the correct port as shown in the figure below. A USB port is labeled with the USB

icon .

Windows will now detect the scanner and will install the necessary files for the scanner
hardware driver.
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Installing Additional Software
If you want to use OCR (Optical Character Recognition) you will have to install Readiris Pro. Insert
the CD-ROM and follow the instructions on your screen.

To enhance and manage your scanned images, insert the Adobe PhotoDeluxe CD-ROM and follow
the instructions on your screen.

! Note: If the Installer Program does not appear automatically, double-click the Setup.exe file on
your CD-ROM.

The Collection CD-ROM contains software to organize and adjust your digital images and to create
your personal Web pages. Insert the Collection CD-ROM and install the desired application(s):

" email VoiceLink Basic (trial version): to add your voice, photos and graphics to email.

" Web!Personal: to create your personal Website.

" Photo Explorer: to acquire, view, organize and adjust digital images and video’s.

" PhotoImpact (trial version): to edit digital images and create Web pages.

For a general overview of the possible workflows, please consult the ScanWise Modes document in
the Agfa ScanWise folder.



Chapter 3: Configuring Buttons on Your PC 19

Chapter 3: Configuring Buttons on Your PC

! Selecting a Different ScanWise Configuration

! Modifying an Existing Configuration

! Creating a New Configuration

! Modifying the ScanWise Settings
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Selecting a Different ScanWise Configuration
It is possible to assign a different configuration to one of the three buttons of your SnapScan. The
following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click the drop-down list next to the e-mail button.

4 Select Scan Image to File (autoselect).

5 Click OK.

Pushing the e-mail button will send the scanned image to a file and not to your mail recipient.

# Note: The same procedure can be applied to the print and ScanWise button.
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Modifying an Existing Configuration
It is possible to modify an existing configuration and assign it to one of the three buttons of your
SnapScan. The following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file and not to your mail recipient.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click Organize.

The Organize Actions window appears.
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The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Select Scan Image to File (autoselect).

5 Click Edit to modify the selected configuration.

The Settings For window appears.
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a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to edit the existing configuration. For more information see
Modifying the ScanWise Settings.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

10 Click Close.

You return to the Configure Buttons window.
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11 Select the name that you have given to your configuration from the drop-down list next to the
e-mail button.

12 Click OK.

Pushing the e-mail button will send the scanned image to a file and not to your mail recipient.

# Note: For low quality originals (originals that are too bright or too dark), we advise you to
select the PhotoGenie check box, which will enhance the colors.

Creating a New Configuration
It is possible to create a new configuration and assign it to one of the three buttons of your
SnapScan. The following example will show you how this is done.

In this example we will create a new configuration and assign it to the e-mail button.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click Organize.

The Organize Actions window appears.
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The Organize Actions window displays all predefined and user defined configurations.

! Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Click New in the Organize Actions window.

The Settings For window appears.

a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.
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! Note: There are several options to create a new configuration. For more information see
Modifying the ScanWise Settings.

5 Select the settings that you want to apply.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

9 Click Close.

You return to the Configure Buttons window.

10 Select the name you have given to your configuration from the drop-down list next to the e-mail
button.

11 Click OK.

The e-mail button is configured with your personal settings.
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Modifying the ScanWise Settings
There are several options to edit an existing configuration or to create a new one.

In the Settings For window following options are available:

" Original Type, Destination, Selection and Color Mode: These options can be changed using
the different drop-down menus.

" Use PhotoGenie: Select the check box Use PhotoGenie if you want to activate the PhotoGenie
software that will enhance both color and detail of your scanned image in case it is too bright or
too dark.

" Resolution: The resolution depends on the destination.

" Dimension: If you want a specified output range, click the Dimension drop-down list. A list of
additional options will appear. Select the dimension (width or height) you want to specify. Enter
the desired range and select the correct unit from the drop-down list. The Keep original size
selection will keep the original size of the image.
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Chapter 4: Installing the Scanner for
Macintosh

This chapter shows you how to set up your SnapScan for your Macintosh.

! Minimum System Requirements

! Installing the Image Editing Software

! Installing the Scanner Software

! Connecting the Scanner to the Macintosh Computer

! Installing Additional Software
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Minimum System Requirements
" A USB port

" A PowerPC® processor

" A 14 inch color monitor with thousands of colors for an accurate display of color images

" 32 MB of RAM

" A CD-ROM drive

" Mac® OS 8.x or OS 9.x

Installing the Image Editing Software
1 Disable the virus protection software.

You can turn it off in the Extensions Manager Control Panel or you can drag the software out of
the System Folder.

# Note: After installing, enable the virus protection software again.

2 Restart your computer.

3 Insert the Collection CD-ROM to install Adobe Photoshop LE 5.0 for Macintosh.

4 Double-click the CD-icon on your desktop.

The Adobe Photoshop LE window appears.

5 Double-click the desired language icon.

6 Double-click the Adobe Photoshop folder.

7 Double-click “Install Photoshop LE”.

8 Follow the instructions on your screen.
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Installing the Scanner Software
1 Insert the Agfa ScanWise CD-ROM in the CD-ROM drive.

The Agfa ScanWise window opens.

# Note: If the ScanWise window does not open automatically, double-click the CD-ROM
icon on your desktop.

2 Double-click the ScanWise Installer icon.

3 Click the up or down arrow to select your language.

This selection determines the language of the ScanWise software and documentation.

4 Click the up or down arrow to select your type of scanner (if needed).

5 Click the dotted right arrow or move the slider to about ScanWise.

A demonstration of ScanWise will start.

6 Click the dotted right arrow or move the handle to Install.

7 Click Acrobat Reader to start the installation.

8 Follow the instructions on your screen.

When Acrobat Reader is installed you will be asked to restart your computer.

9 Click ScanWise to start the installation.

10 Follow the instructions on your screen.

# Note: After installation the Register ScanWise window appears.

$ Register now: If you choose to register now, the Agfa webpage opens. Here you can
register online.

$ Register later: If you choose to register later, you can register afterwards by double-
clicking the ‘Product Registration’ icon in the ScanWise folder.
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By registering online, you will create your personal e-Service account and you will enjoy the
following benefits:

1. Customized self-help tools:

You have access to the following self-help tools which are customized according to your
e-service account profile:

1. Software downloads

2. Technical knowledge database (FAQ)

3. Online manuals and documentation

4. Access to third-party software support sites

2. Personalized one-to-one technical support:

Agfa assists you online if you have additional questions about technical issues.

3. Automatic e-mail notification:

Agfa notifies you immediately when new software and upgrades are available for downloading.

# Note: For support issues, go to http://support.agfa.com.

# Note: For the latest information consult the ScanWise Read Me File.

When the installation is finished you are ready to connect your scanner to your Macintosh
computer.

Caution: Before using ScanWise on a system with 32 MB physical RAM, it is advised to increase
the virtual memory to 64 MB:

1 Choose Control Panels > Memory from the Apple menu ( ).
The Memory window appears.

2 Increase the virtual memory to 64 MB.
3 Restart your Macintosh.

http://support.agfa.com/
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Connecting the Scanner to the Macintosh
Computer
Caution: For your safety, use the adapter that comes with this product. Do not use any substitute.
Misuse of the power adapter can cause serious damage to the product and a safety hazard while
using it.

# Note: Check if the AC Adapter complies with your local power supply.

# Note: Make sure the scanner is unlocked (see Unlocking the Scanner) before connecting it to
the electric outlet.

1 Connect the plug of the AC adapter to your scanner.

2 Plug the adapter cable in the wall outlet.

3 Connect one end of your USB cable to the USB port on your scanner.

Make sure you connect the correct plug as shown in the figure above.

4 Connect the other end of your USB cable to a USB port on your computer.

Make sure you connect it to the correct port as shown in the figure below. A USB port is
marked with the USB icon .
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Installing Additional Software
If you want to use OCR (Optical Character Recognition) you will have to install Readiris Pro.

1 Insert the Readiris Pro CD-ROM.

2 Double-click the CD-ROM icon on your desktop.

3 Double-click the installation icon of the language of your choice.

4 Follow the instructions on your screen.

For a general overview of the possible workflows, please consult the ScanWise Modes document in
the Agfa ScanWise folder.
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Chapter 5: Configuring Buttons on Your
Macintosh Computer

! Selecting a Different ScanWise Configuration

! Modifying an Existing Configuration

! Creating a New Configuration

! Modifying the ScanWise Settings
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Selecting a Different ScanWise Configuration
It is possible to assign a different configuration to one of the three buttons of your SnapScan.
Following example will show you how it is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click the drop-down list next to the e-mail button.

4 Select Scan Image to File (autoselect).

5 Click OK.

Pushing the e-mail button will send the scanned image to a file and not to your mail recipient.

# Note: The same procedure can be applied to the print and ScanWise button.



Chapter 5: Configuring Buttons on Your Macintosh Computer 36

Modifying an Existing Configuration
It is possible to modify an existing configuration and assign it to one of the three buttons of your
SnapScan. The following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file and not to your mail recipient.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click Organize.

The Organize Actions window appears.

The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.
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4 Select Scan Image to File (autoselect).

5 Click Edit to modify the selected configuration.

The Settings For window appears.

a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to edit the existing configuration. For more information see
Modifying the ScanWise Settings.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

10 Click Close.

You return to the Configure Buttons window.
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11 Select the name that you have given to your configuration from the drop-down list next to the
e-mail button.

12 Click OK.

Pushing the e-mail button will send the scanned image to a file and not to your mail recipient.

# Note: For low quality originals (originals that are too bright or too dark), we advise you to
select the PhotoGenie check box, which will enhance the colors.

Creating a New Configuration
It is possible to create a new configuration and assign it to one of the three buttons of your
SnapScan. The following example will show you how this is done.

In this example we will create a new configuration and assign it to the e-mail button.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. Print button

b. ScanWise button

c. E-mail button

3 Click Organize.

The Organize Actions window appears.
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The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Click New in the Organize Actions window.

The Settings For window appears.

a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to create a new configuration. For more information see
Modifying the ScanWise Settings.
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5 Select the settings that you want to apply.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

9 Click Close.

You return to the Configure Buttons Window.

10 Select the name that have given to your configuration from the drop-down list next to the
e-mail button.

11 Click OK.

The e-mail button is configured with you personal settings.
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Modifying the ScanWise Settings
There are several options to edit the existing configuration or to create a new one.

In the Settings For window following options are available:

" Original Type, Destination, Selection and Color Mode: These options can be changed using
the different drop-down menus.

" Use PhotoGenie: Select the check box Use PhotoGenie if you want to activate the PhotoGenie
software that will enhance both color and detail of your scanned image in case it is too bright
or too dark.

" Resolution: The resolution depends on the destination.

" Dimension: If you want a specified output range, click the Dimension drop-down list. A list of
additional options will appear. Select the dimension (width or height) you want to specify. Enter
the desired range and select the correct unit from the popup list. The Keep original size
selection will keep the original size of the image.



Chapter 6: Making Your First Scan 42

Chapter 6: Making Your First Scan

1 Place a color photograph face down on the glass plate with the top side against the middle of
the front ruler.

The optical performance of a CCD scanner is always best near the middle of the glass plate.
However, the specified scan quality is guaranteed for the entire scan area.
If you put more than one original on the glass plate, position them as close to the center line as
possible to optimize the quality.

2 Close the document cover of the scanner.

# Note: The adjustable document cover makes it possible to scan from books and
magazines. When you put a thick original on the reflective glass plate, the document
cover adapts to the thickness of the original.

3 For PC: In the Start menu, select Programs, Agfa ScanWise to open the ScanWise
application.

-or-

For Macintosh: Go to the Agfa ScanWise folder on your hard disk and double-click .

4 Select your scanner (if needed).

# Note: This dialog only appears the first time you use ScanWise.

5 Click Yes when the system asks to guide you.

6 Follow the steps described in the ScanWise Guide Me mode.

For more information consult the ScanWise Application Guide and the Agfa Contacts on your Agfa
ScanWise CD-ROM. After installation you can access these documents via the Start menu on your
PC or via the ScanWise icon on the desktop of your Macintosh.

# Note: If you encounter problems, please consult the ScanWise Read Me file on your computer
or refer to Appendix A: Troubleshooting in this Owner’s Guide.
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Appendix A: Troubleshooting

This section gives solutions for some common problems you may come across when starting up or
using your SnapScan.

There is no USB port free for your scanner.

" Check if you can use a USB port on the keyboard or monitor.

" Use a USB hub.

The status indicator fails to light up.

" Verify the power connection to the scanner.

" If the power connection is working, contact your dealer or local Agfa support center.

The scanner makes an unusual noise and the scanner lamp does not move back and forth
when you connect the scanner.

" The scanner was not properly unlocked. Immediately disconnect the AC adapter and unlock
the scanner properly, or contact your dealer or local Agfa support center.

The scanner or lamp flickers, dims, or fails to light up.

" The cold cathode lamp of your scanner needs to be replaced. Contact your dealer or local
Agfa support center.

ScanWise cannot find the scanner (MACINTOSH ONLY).

If the scanner driver cannot find the scanner, a message appears telling you that no scanner is
connected.

" Check if the scanner is connected with the USB cable to your computer and that the AC
adapter is plugged in. It can always happen that a USB port is damaged, therefore try the other
USB port of your computer.

" Open the Apple System Profiler that you find under the  menu. Click the tab “Devices and
Volumes” (minimum version 8.5). Here you can check if the USB device is found. If USB is not
present in the list of Devices and Volumes, please check the hardware (cable, USB ports).

" Disconnect the AC adapter and reconnect it again.

# Note: If you encounter other problems during or after installation, please consult the ScanWise
Read Me file on your computer.

The driver is not found when you connect the scanner to your computer (MACINTOSH ONLY).

If ScanWise is not installed correctly, the following message appears: “The software needed to use
the device SnapScan e26 cannot be found”.

" Re-install ScanWise.

" Check if the Extensions folder contains the file “Agfa USB e26”. This driver is necessary for
detecting the scanner.
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Windows 98 fails to detect the scanner when you connect it for the first time (PC ONLY).

" Check if the scanner is connected with the USB cable to your computer and that the AC
adapter is plugged in. It can always happen that a USB port is damaged, therefore try the other
USB port of your computer.

" Check if the Device Manager finds the USB controller. To check if the USB controller is
present in the Device Manager, click with the right mouse button on the icon My Computer and
select Properties from the menu that pops up. Select the Device Manager tab from the System
Properties dialog box.

$ If the USB controller ( ) is present in the Device Manager, carry out the scanner
installation procedure exactly as described in this manual.

$ If the USB controller is not present in the Device Manager, carry out the following
instructions:

1 Restart your computer.

2 Enable the USB controller in the BIOS settings.

Caution: Changing your computer’s BIOS settings is at your own risk! It should be done by
system administrators and experienced users only. If you are not familiar with these tasks, ask
your computer dealer to do this for you.

You typically do this by pressing a key combination during the startup of your PC. Consult
your computer manual for more information.

3 Exit and save the changes you made.

Your computer is rebooted automatically.

" Check again if the Universal serial bus controller is present in the Device Manager.

$ If the Universal serial bus controller ( ) is present in the Device Manager, carry out the
scanner installation procedure exactly as described in this manual.

$ If the Universal serial bus controller is still not present in the Device Manager, carry out
the following instructions:

1 Click the Start button.

2 Select Settings.

3 Select Control Panel.

4 Double-click the Add New Hardware icon.

5 Attentively follow the instructions that appear on your screen.

The Universal Serial Bus controller should now be present in the Device Manager. Carry out the
scanner installation procedure exactly as described in this manual.

An OEM Windows 98 system was already installed when purchasing your computer (PC
ONLY).

When you encounter problems during the installation procedure on a PC with a pre-installed
Windows 98 system, please contact your PC dealer.
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The e-mail function is not working (PC ONLY).

ScanWise PC uses the default MAPI (Microsoft Messaging API) client as e-mail destination. This
means you need a MAPI compatible e-mail client and it also has to be configured correctly. If
ScanWise cannot find such a destination, the e-mail destination will NOT be visible in the
destination list.

Examples of MAPI compatible clients: Microsoft Outlook and Outlook Express, Netscape
Messenger, Eudora Pro.
Example of a non MAPI compatible client: Compuserve for Windows.

Some configuration examples:

" If you are using MS Outlook Express v4.x and it does not show up in the ScanWise destination
list, choose Options in the Tools menu in Outlook Express and make sure that the following
items are checked:

$ Make Outlook Express my default e-mail program.

$ Make Outlook Express my default Simple MAPI client.

This should solve the problem.

" If you are using MS Outlook Express v5, choose Tools, General in the Tools menu in MS
Outlook Express. If Outlook is not the default e-mail client, click the ‘Make default’ button.

" You can also choose Internet Options, Programs in the Control Panel and indicate your e-mail
client there.

# Note: If ScanWise cannot find an e-mail destination, ScanWise will ask you to assign another
action to the default e-mail button of your scanner.

Your problem is not solved.

For support issues, go to http://support.agfa.com or consult the Information sheet that comes with
your scanner.

http://support.agfa.com/
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Appendix B: Technical Information

Technical specifications are subject to change without notice.

Scanner type:

- SnapScan e26 Desktop, flatbed, one pass, 3 buttons of which all are
software definable

Maximum resolution:

- optical: 600 ppi horizontal x 1200 ppi vertical

- through interpolation: 9600 ppi horizontal x 9600 ppi vertical

- Internal sample depth: 16 bits for gray, 48 bits for color

Scanning speed:

- line-art: 6.5 ms / line

- gray: 6.5 ms / line

- color: 7.4 ms / line

Maximum scanning area 216 x 297 mm (8.5 '' x 11.7 '')

Lamp for reflective scanning: Cold cathode

AC-adapter:

- Input voltage:

- Input frequency:

100 to 240 V

47 to 63 Hz

Power consumption: 25 W

Scanner dimensions:

- length: 432 mm (17”)

- width: 273 mm (10.8 “)

- height: 70 mm (2.8 “)

- weight: 2.5 kg (5.5 lb)

Interface: USB port

Transmission speed: 1 mbyte/s

Environmental specifications:

- operating temperature: +10 °C to +40 °C (+50 to +104 degrees Fahrenheit)

- relative humidity: 20% to 85% RH

- surrounding space: 10 cm (4 “) on every side
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Appendix C: Regulation Compliance
! Safety Regulations

! UL Safety Statement

! TÜV: Wichtige Sicherheitshinweise

! Electromagnetic Compatibility

! Federal Communications Commission Radio Frequency Interference Statement

! Industry Canada Class A and B Label Requirements

! Declaration of Conformity: SnapScan e26
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Safety Regulations
SnapScan and its options are designed to comply with:

" UL 1950

" CSA C22.2 No. 950 - M89 D3

" VDE 0805

" IEC 950

" GS approved

" EN 60950

UL Safety Statement

The SnapScan and the AC adapter are suited for indoor use only. Do not use them outdoors.

Use the Agfa supplied AC adapter only, otherwise guarantee will be voided.

For the reason of safety, besides the personal maintenance mentioned in this operation manual, do
not try to remove any mechanical parts or any electronic devices. If your scanner needs service, our
dealer and service offices are available to help you.

TÜV: Wichtige Sicherheitshinweise

Bitte Lesen Sie sich diese Hinweise sorgfältig durch.

Um eine Beschädigung des Gerätes zu vermeiden sollten Sie nur Zuberhörteile verwenden, die
vom Hersteller zugelassen sind.

Das Gerät ist vor Feuchtigkeit zu schützen.

Bei der Aufstellung des Gerätes ist auf sicheren Stand zu achten. Ein Kippen oder Fallen könnte
Verletzungen hervorrufen. Verwenden Sie nur sichere Standorte und beachten Sie die
Aufstellhinweise des Herstellers.

Die Belüftungsöffnungen dienen zur Luftzirkulation die das Gerät vor Überhitzung schütz. Sorgen
Sie dafür, daß diese Öffnungen nicht abgedeckt werden.

Die Netzanschlußsteckdose muß aus Gründen der elektrischen Sicherheit einen
Schutzleiterkontakt haben.

Durch die Lüftungsöffnungen dürfen niemals Gegenstände oder Flüssigkeiten in das Gerät
gelangen. Dies könnte einen Brand bzw. elektrischen Schlag auslösen.

Öffnen Sie niemals das Gerät. Das Gerät darf aus Gründen der elektrischen Sicherheit nur von
authorisiertem Servicepersonal geöffnet werden.

Die Steck dose sollte nahe dem Gerät und leicht zugänglich sein.
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Electromagnetic Compatibility
SnapScan is designed to comply with:

" Emission EN55022, class B

" Immunity IEC 801-2, IEC 801-3, IEC 801-4

" 47 CFR, part 15, subpart B, class B

Federal Communications Commission Radio Frequency
Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

" Reorient or relocate the receiving antenna.

" Increase the separation between the equipment and receiver.

" Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

" Consult the dealer or an experienced radio/television technician for help.

Industry Canada Class A and B Label Requirements

This Class [select A or B] digital apparatus meets all the requirements of the Canadian Interference
Causing Equipment Regulations.

Cet appareil numérique de la classe [A/B] respecte toutes les exigences du Règlement sur le
matériel brouilleur du Canada.
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Declaration of Conformity: SnapScan e26

Manufacter’s authorized:

Per Säve

Agfa-Gevaert N.V.

Septestraat 27

B-2640 Mortsel

Declares that the product

Agfa SnapScan e26

Color image scanner

Complies with the requirements of the Low Voltage Directive 73/23/EEC, 93/68/EEC

The product SnapScan e26 complies with the following standards:

EN 60950: 1992/A1: 1993

Complies with the requirements of the EMC directive 89/336/EEC

The product SnapScan e26 complies with the following standards:

EN 55022 class B

EN 50082 – 1 -,

IEC 801-2, IEC 801-3, IEC 801-4

The product is marked with the CE marking.

Per Säve

Vice-president CI/CDI

Agfa-Gevaert N.V.
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